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In this section:

Managing a 
Calendar

The Microsoft Outlook 2010 calendar simplifies the burden of 
keeping and maintaining a schedule of meetings, appoint-

ments, events, and tasks. At a glance, you can quickly see your 
agenda in daily, weekly, or monthly views. With Outlook, you 
won’t have any excuses for missing a lunch date or forgetting a 
meeting.

Outlook enables you to keep track of recurring meetings or 
events so that you don’t have to manually enter these items each 
time they take place. For example, you might have a weekly staff 
meeting that takes place every Friday from 9:00 A.M. to 10:00 
A.M. Make it a recurring meeting, and Outlook blocks out that 
day and time. Similarly, if your PTA meets every third Tuesday 
of the month at 7:00 P.M., you can set Outlook to schedule that 
meeting as well.

Outlook includes an alert that displays a message prior to 
your Calendar meeting, appointment, or task so that you won’t 
forget it. For example, you can set up Outlook to display a 
reminder of an upcoming meeting two or three days before its 
occurrence. If you need to prepare a presentation, document, or 
other item for the meeting, you give yourself ample time to do 
so. You then can “snooze” the reminder so it gets your attention 
again later, but perhaps only three hours prior to the meeting.

8
■■ Viewing Your Calendar

■■ Adding an Appointment

■■ Adding an Event

■■ Setting Up a Meeting

■■ Updating Calendar Information

■■ Inserting Items, Objects, and Files in a 
Calendar Item

■■ Working with Reminders

■■ Sharing Calendar Information

■■ Printing Calendars



Viewing Your Calendar
You can view your Outlook calendar in several different for-
mats. Day view is an hour-by-hour view of your daily sched-
ule, whereas Month view shows your schedule for the entire 
month. The Date Navigator is a small calendar with which you 

can navigate quickly to a specific day, week, or month, while 
the To-Do Bar consolidates all of the features of task list, Date 
Navigator, and appointment list into one task pane.

Use the Date Navigator

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Click the Day button on the Home 
tab.

3	 Click a day on the Date Navigator to 
display it in the Calendar view.

4	 Click to the left of a week on the Date 
Navigator to display that week in the 
Calendar view.

5	 Click the right arrow on the Date 
Navigator to move to the next 
month.

2

1

You can access the current, 
last three, and next three 
months by clicking the 
month name in the Date 
Navigator. This is handy if 
you want to jump back a few 
months or jump forward a 
month or two.

Tip

To see today’s date, click the 
Today button in the Go To 
group on the Home tab. If the 
current month is showing in 
the Date Navigator, click the 
boxed date to display today’s 
date.

Try This!

5

4

3
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Use the Calendar View

1	 Click the Calendar icon on the Navigation 
Pane.

2	 Click to see an hourly breakdown of your 
day.

3	 Click Work Week to see a workweek’s 
schedule by hour.

4	 Click Week to see a week’s scheduling 
(including weekend days).

5	 Click Month to see a month’s schedule.

You can make more room available for the Calendar pane on 
the screen by resizing or minimizing the Navigation Pane.

Tip

To return to today’s date, right-click inside a view and choose 
Today from the shortcut menu that appears.

Tip

2 3 54

1
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Use the To-Do Bar

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Click the View tab.

3	 Click Layout.

4	 Click To-Do Bar, and then choose 
Normal.

2 3 4

1

Choose the Minimized option from the To-Do 
Bar submenu to make the To-Do Bar auto-
matically hide at the edge of the Outlook 
window.

Tip

Depending on the options you set for the 
To-Do Bar, portions of the Appointments or 
Tasks areas of the To-Do Bar might be blank.

Tip

5	 Click a date on the Date Navigator to 
view appointments for that date.

6	 View upcoming appointments.

7	 View current tasks.

5

6

7
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Adding an Appointment

Add an Appointment with the Menu

1	 Click the Calendar icon on the Navigation 
Pane.

2	 Select a block of time for the appointment.

3	 Click New Appointment on the Home tab.
(continued on next page)

3

1 2

An appointment in Outlook is an activity you enter for a spe-
cific time that, unlike a meeting, doesn’t typically involve other 
people or resources. When you schedule an appointment, you 
block out a day, a time, and a location for that appointment 

to occur. As mentioned earlier, Outlook also lets you set a 
reminder that flashes on your screen and plays a sound to alert 
you to the appointment. To learn how to set a reminder, see 
the task “Working with Reminders” on page 144.

Keep your appointment subjects as short as 
possible so that they’re easy to read in the 
Calendar view.

Tip
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Add an Appointment with the 
Menu  (continued)

4	 Type a description of the appoint-
ment in the Subject box.

5	 Type the location of the appointment 
in the Location box.

6	 Click the down arrow to the right of 
the Start Time date, and select the 
day of the appointment.

7	 Click the down arrow to the right of 
the Start Time hour, and select the 
starting time of the appointment.

8	 Click the down arrow to the right of 
the End Time date, and select the 
ending day of the appointment if the 
appointment spans multiple days.

9	 Click the down arrow to the right of 
the End Time hour, and select the 
ending time of the appointment.

10	 Add notes if you want.

11	 Click the Save & Close button.

11 6 74 5

9

810

If you’d like to add extended information about an appoint-
ment, click in the text area at the bottom of the Appointment 
window. Type a longer description here, such as directions to 
the appointment location, important information about the 
appointment, and so on.

Try This!

You can print your appointments to the default printer by click-
ing the Print button on the File tab.

Tip
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Add an Appointment Right on the Calendar

1	 Click the Calendar icon on the Navigation pane.

2	 Click and drag to select a block of time for the 
appointment on the Calendar.

3	 Begin typing the Subject of the appointment, 
and the subject appears in the blocked-out 
space on the Calendar. 

4	 Press Enter.

5	 Double-click the appointment to open the 
appointment form.

6	 Add the location, notes, and other information 
to the appointment. 

7	 Click the Save & Close button.
1

2
3

5

7 6

If you use Outlook with a Microsoft 
Exchange Server account, others can easily 
see your free/busy time. They know when 
you’re busy and can schedule meetings with 
you based on this information.

Tip

To categorize the appointment, right-click 
the appointment and choose Categorize, and 
then choose a category from the submenu.

Tip
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Adding an Event
An event is an activity that runs for 24 hours or longer. An 
example of an event is a weeklong conference or seminar that 
you attend. Events display as banners at the top of the day and 
run from midnight to midnight, so they don’t take up blocks of 

time on the Calendar. This display method leaves room in your 
calendar for you to show appointments or meetings that you 
might schedule during event days.

Describe the Event

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Click a day on the calendar.

3	 Click the New Items button.

4	 Choose All Day Event from the short-
cut menu.

5	 Type a description of the event in the 
Subject box.

6	 Type the location of the event in the 
Location box.

7	 Click the Save & Close button.

3 4 2

1

7 5 6

To add an all-day event to a day other than 
the current day, display the week or month, 
right-click on the day, and then choose New 
All Day Event.

Tip

You can add more information about an event to the text area 
at the bottom of the Event window.

Try This!
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Change the Event’s Scheduled Date

1	 Create a new event.

2	 Add a subject and location for the 
event.

3	 Click the Start Time date down arrow 
and select the starting day of the 
event.

4	 Click the End Time date down arrow 
and select the ending day of the 
event if it is a multiple-day event.

5	 Click the Save & Close button.

5 32

4

1

You may already have events entered in your Calendar folder. 
When you create a new contact in the Contacts folder and 
include a birthday or anniversary for the contact, Outlook 
schedules that date as an event in the calendar.

Tip

For information on setting up contacts, see Section 7, “Work-
ing with Contacts,” starting on page 99.

See Also
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Setting Up a Meeting
A meeting is an activity (often a physical meeting or confer-
ence call) that involves other people and sometimes resources. 
A resource can be a conference room, VCR, slide projector, tele-
phones, laptop computer, or other equipment. Usually a meeting 

involves you and at least two other people (but can certainly be 
just you and one other person). Outlook sends a meeting invita-
tion to every person you designate, and they can accept or reject 
the request or propose a new time for the meeting.

Create a Meeting in a Block of Time

1	 Click the Calendar icon on the Navigation 
Pane.

2	 Highlight a block of time on the meeting 
day for the meeting.

3	 Click New Meeting on the Home tab.
(continued on next page)

23

1

You can use the Scheduling Assistant to help you find a time 
that is open for all invitees, and you can also identify available 
resources. To switch to the Scheduling Assistant view, click 
Scheduling Assistant in the Show group on the Meeting tab of 
the ribbon.

Tip
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Create a Meeting in a Block of 
Time  (continued)

4	 Click To.

5	 Select attendees and resources 
from the Address Book, or type the 
addresses manually.

6	 Click Required if the invitee needs to 
attend.

7	 	Click Optional if the invitee isn’t 
required to attend.

8	 Click OK when you are done.

9	 Type a description of the meeting in 
the Subject box.

10	 Type the location of the meeting in 
the Location box.

11	 Add notes, directions, or comments 
for the meeting as needed.

12	 Click Send.

5

7 6 8

4 9 10

12

11

When you type your meeting subject, keep it short 
but descriptive. “Team Meeting” may not be enough 
if people are members of multiple teams. Use some-
thing specific like “Development Team Meeting” for 
your description.

Try This!
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Change the Meeting Date and Time 

Outlook uses the currently selected date and 
time by default when you create a new meeting 
request. You can change the date and time as 
you need to, rather than accept the default.

1	 Create a new meeting.

2	 Add attendees, a subject, and a location 
for the meeting.

3	 Click the down arrow in the Start Time 
date field, and select the starting date.

4	 Click the down arrow in the Start Time 
hour field, and select the starting time of 
the meeting.

5	 Click the down arrow in the End Time hour 
field, and select the ending time of the 
meeting.

6	 Click Send.

13

6

2

4

5

Make sure that your attendee list has correct e-mail addresses. 
If you attempt to send the meeting request to someone not 
in one of your address books, Outlook lets you know that the 
person can’t be validated.

Caution

For information on the Address Book and adding new contacts, 
see Section 7, “Working with Contacts,” starting on page 99.

See Also Outlook provides the Scheduling Assistant to help you set up 
meetings with other people in your organization. The Schedul-
ing Assistant lets you see other people’s schedules if they have 
mailboxes in the same Exchange Server environment.

Tip
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Updating Calendar Information
Outlook lets you edit a meeting, appointment, 
or event information saved in the Calendar 
folder. You might, for example, need to modify 
the time an appointment starts or ends, change 
where a meeting is held, or adjust the date of 
an event. When you change a meeting, you can 
send new meeting messages to attendees to 
announce the change.

Change an Appointment

1	 Click the Calendar icon on the Navigation 
Pane.

2	 Double-click the appointment you want to 
change. (If you open a recurring appoint-
ment, Outlook asks whether you want to 
change the occurrence or the series.)

3	 Make changes to the appointment.

4	 Click the Save & Close button.

1 24

3

Any date that has a meeting, appointment, or event appears 
in bold on the Date Navigator. Click that date to switch to the 
day, week, or month in which that activity occurs.

Tip

Make an appointment recurring by clicking the Recurrence 
button and filling out the Appointment Recurrence informa-
tion. For example, set the time for the appointment to occur 
from 8:00 A.M. to 10:00 A.M. every Thursday.

Try This!
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Update Event Information

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Double-click the event you want to 
change.

3	 Make changes to the event.

4	 Click the Save & Close button.

2

1 4 3

Events appear at the top of Day and Week 
views and are shown within a box in Month 
view.

Tip

If you deselect the All Day Event option on the Appointment 
tab for the event, you may create a conflict with appointments 
or meetings you’ve already set up for that day. Remember that 
events run for 24 hours—from midnight to midnight.

Caution
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Reschedule a Meeting

1	 Open the meeting you want to 
change. If it is a recurring meeting, 
specify whether you want to change 
the occurrence or the series.

2	 Change the start day, if needed.

3	 Click the Start Time hour drop-down 
list, and select the new start time.

4	 Click the End Time hour drop-down 
list, and select the new end time.

5	 Click Send Update.

1

5

3

2 4

You can reschedule a meeting simply by dragging it to a new 
location on the Calendar. Regardless of the method you use to 
move the meeting, Outlook can automatically send an update 
to all attendees with notice of the new day and time.

Tip

Use the Tracking button on the Meeting tab to see which 
attendees have responded to your meeting request.

Tip
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Inserting Items, Objects, and Files in a Calendar Item
Outlook enables you to insert objects, files, and Outlook items 
into your Calendar items. For example, you may have a meet-
ing to which you want to take an important document or an 
agenda. You can insert the document into the meeting item 

so that you don’t forget to take it with you and so that other 
attendees have a copy of it. You can add contacts from Outlook 
to a calendar item in much the same way.

Add an Outlook Item

1	 Open an appointment, meeting, or 
event.

2	 Click the Insert tab on the ribbon.

3	 Click Outlook Item.

4	 Select the Outlook folder in which the 
item is stored.

5	 Select the Outlook item you want to 
insert from the Items list.

6	 Click OK. The selected item now 
appears in the comment field. 

7	 Click the Meeting, Appointment, or 
Event tab, and then click Save & Close 
(for an appointment or event) or Send 
Update (for a meeting).

3 2 1

4 6

5

Outlook uses an item-specific 
icon to indicate the type of 
Outlook item that you can 
insert, such as a note icon for 
a note item or calendar icon 
for a calendar item.

Tip

To insert the text contained in 
a contact rather than the con-
tact address card itself, select 
the Text Only option in the 
Insert Item dialog box.

Try This!

7

The selected item appears in the
comment field.
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Add a File

1	 Double-click an appointment, 
meeting, or event.

2	 Click the Insert tab on the 
ribbon.

3	 Click the Attach File button.

4	 Select the file you want to 
insert.

5	 Click Insert. The added file 
appears in the comment field. 

6	 Click the Meeting, Appoint-
ment, or Event tab, and then 
click Save & Close (or Send 
Update, for a meeting).

3 2

4 5

6

The added file appears in the
comment field.

To delete a file, item, or object from a Calendar item, select the 
item and press Delete.

Tip
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Add an Object from a File

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Double-click an appointment, meeting, 
or event.

3	 Click the Insert tab on the ribbon, 
and then click in the notes area of the 
item.

4	 Click Object on the Text group of the 
ribbon’s Insert tab.

5	 Click the Create From File tab.

6	 Click Browse.
(continued on next page) 1 23 4

5 6
Because you can add objects from a file, you 
can also embed a portion of a spreadsheet 
or other type of document in the appoint-
ment item for reference. For example, if you 
are discussing a project issue list in a meet-
ing, you might embed the issue list from a 
Microsoft Excel spreadsheet in the meeting 
request so that the participants can review it 
before the meeting. 

Tip
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Add an Object from a File  (continued)

7	 In the dialog box, click the object you 
want to add.

8	 Click Insert, and then click OK in the 
Object dialog box. The added object 
appears in the comment field.

9	 Click the Appointment, Meeting, or 
Event tab, and then click Save & Close 
(or Send Update).

9

The added object appears in the
comment field.

To create a new object, such as an Excel worksheet, select 
Create New in the Insert Object dialog box. When you click 
OK to insert the object, you then create the new object in 
that object’s native application (such as Excel).

Tip

7

8
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Working with Reminders
You can have Outlook display a reminder of upcoming 
appointments, events, or meetings. The reminder displays in 
a message box and can sound an alarm to alert you. You can 
use any sound included with Windows or use a sound that 
you’ve downloaded from the Internet and saved to your hard 

drive. Outlook adds a 15-minute reminder automatically when 
you create appointments or meetings, so you need to use the 
following process only if you want to add a reminder to an 
item that doesn’t have one or when you want to change the 
reminder.

Add or Change a Reminder

1	 Open the appointment, meeting, or 
event for which you want to set a 
reminder.

2	 In the Options group on the ribbon’s 
Appointment tab, choose a reminder 
time.

3	 Click the Save & Close button. Outlook 
reminds you of the appointment at the 
scheduled time.

3 2

Reminders display even if the Calendar item is overdue. For 
example, if an event was set for Saturday and you didn’t turn 
on your computer that day, the next time you start Windows, 
the reminder for that event appears. You can dismiss the 
reminder at that point.

Tip

You can set up reminders for meetings and events by following 
the same sequence of steps shown here for appointments.

Tip
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Outlook enables you to share Calendar 
information with others. You can forward a 
Calendar item by e-mail to other Outlook 
users, or you can forward an iCalendar 
item to any user of any Internet-connected 
mail program. You should use iCalendar 
when you schedule meetings with people 
who don’t use Outlook.

Forward a Calendar Item

1	 Open an existing meeting item.

2	 Click the Meeting tab of the ribbon.

3	 Click the Forward button.

4	 Type the e-mail address of the recipi-
ent in the To box.

5	 Click Send.

23

5 4

Sharing Calendar Information
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Forward an Item As iCalendar

1	 Open a meeting item by double-
clicking it in the Calendar.

2	 Click the Meeting tab on the ribbon. 
This tab is named Meeting Series for 
a recurring meeting.

3	 Click the arrow beside the Forward 
button.

4	 	Choose Forward As iCalendar. The 
item appears as an attachment. 

5	 Type the e-mail address of the recipi-
ent in the To box.

6	 Click Send.

2 43

6 5

The item appears as an attachment.

If you forward a calendar item that has an attachment, that 
attachment is forwarded along with the calendar item.

Tip

iCalendar is for communicating with people who don’t use 
Outlook. If you want to forward a Calendar item to someone 
who uses Outlook, use the Forward command on the Actions 
menu or click Forward in the Actions group on the meeting 
form’s ribbon.

Tip
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Printing Calendars
You can print your Outlook appointment 
calendar, such as your daily or weekly 
appointments, meetings, and events. Or 
you can print an individual calendar item, 
such as a meeting item.

Print your Appointment Calendar

1	 Click the Calendar icon on the 
Navigation Pane, and then click File.

2	 	Choose Print.

3	 Choose a calendar style in the Print 
Style area.

4	 Click Print.

1

2

4

3

Print your appointment calendar at the beginning of each 
week so that you can keep track of all your upcoming events, 
appointments, and meetings. As schedules change, such as a 
meeting being delayed or canceled, make these changes on 
the hard copy as well as in Outlook. If too many changes hap-
pen, of course, you need to print a fresh calendar.

Try This!

You can print your calendars in Daily, Weekly, Monthly, Tri-fold, 
Calendar Detail, and Memo Style. Print your calendar in each 
one of these styles and pick your favorite one.

Tip
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Print a Calendar Item

1	 Click the Calendar icon on the 
Navigation Pane.

2	 Double-click the Calendar item you 
want to print.

3	 Click File.

4	 Click Print.

5	 Set print options.

6	 Click Print.

1

2

3 4 6 5

If you want to print to a printer other than the default one, 
click the Printer drop-down list and select the printer.

Tip

Print a Calendar item that has an attachment inserted in it. 
Click Print Options, and when the Print dialog box appears, 
select Print Attached Files to print the attachment.

Try This!
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Index

Symbols
% Complete property of task, 154, 158

A
Access database, importing data from, 

226
Account Settings dialog box

E-mail tab
Exchange Server account, 235

Find A Text Messaging Servce For Your 
Mobile Operator, 180

activities, associated with contact, 109
Add New Account dialog box, 38
Add New Category dialog box, 208
Address Book, 48, 50–51

adding contacts, 106
finding name in, 51
to select person for e-mail alert, 179

Address Cards, 111
information entry, 100

addresses
for e-mail messages, 48
importing from other programs, 40

Advanced Find dialog box, 25, 114
alarm for calendar item, 144
alerts

configuring settings for Exchange 
Server accounts, 174–175

for important messages, 178–179
for meetings and appointments, 125
for SharePoint calendar changes, 189
sending to mobile devices, 173, 183–185
setting up Calendar, 176–177
to mobile device, 26

All Day Event, 132, 138
All Outlook Items folder list, 216
anniversary, as calendar event, 133
antivirus program, 79
applications

creating shortcut for, 247
for opening attachments, 79

appointments, 34
adding file to, 141
adding information about, 130
adding Outlook item to, 140
adding to Calendar, 129–131

with menu, 129–130, 130–131
changing, 137
embedding spreadsheet portion, 142
opening, 43
printing, 130, 147
recurring, 137
reminders for, 144

archive, display in Navigation Pane, 15
archiving

exporting items for, 228
Outlook data files, 233–234
to Outlook data file, 234

assigning tasks to another, 166–168
assumptions, 4
attached faxes, search folder for messages 

with, 211
attachments

forwarding with calendar item, 146
printing, 148
to e-mail, 79–80

forwarding, 82
saving, 80, 82

to tasks, 162
attachments to e-mail, 64–65, 65
audio reminder, 155
AutoArchive dialog box, 233
AutoArchive options for folder, 218, 219

AutoArchive, setting options, 233
AutoDialer option, 121
availability, viewing, 200

B
Backstage view, 10–11

Account Settings, Manage Mobile 
Notifications, 26

backup of contacts, 105
backup of Outlook data, 230–232

exporting items for, 228
of archive file, 234

Bcc field, 160
Bing Web site, 110
birthday, as calendar event, 133
body of e-mail message, 49
boilerplate text, 59
boldface, e-mail messages in, 72
bold text, 6, 58
Business Card, 111
busy time

calendar display of, 16–17
Exchange Server account for sharing, 

131

C
Cached Exchange Mode, configuring 

Outlook for, 235–236
Calendar, 125

adding appointment, 129–131
directly on Calendar, 131
with menu, 129–130, 130–131

adding event, 132–133
adding object from file, 142–143, 

143–144
adding to Outlook from SharePoint, 

188–192
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Calendar (continued)
alerts to mobile device

sending, 183
setting up, 176–177

customizing, 241–242
Daily Task List, 150
event updates, 138
inserting items, objects and files, 

140–143
meeting rescheduling, 139
meeting setup, 134–136
new features, 16–20
notifications of updates, 177
preview for invitation, 18–19
printing, 147–148
reminders, 144
sharing information from, 145–146
Task List in, 152
updating information, 137–139
viewing, 126–128

Calendar folder, 33
calendar items, creating in Outlook for 

SharePoint, 191
Calendar view, 127
categories, 206–210

adding to category list, 208
assigning multiple, 207
deleting, 210
for contact organization, 117
for items, 206
name changes, 209

Categorized Mail search folder, 212
items without color associated, 211

CD drive, backing up PST file to, 231
cell phone, alerts to, 173
cleaning up folders, 218–219
closing

Address Book, 51
Outlook item, 35

color
Categorized Mail search folder item 

without, 211
for categories, 206
indicator of person’s availability, 200
of e-mail message text, 58

Color Categories dialog box, 117, 208
color schemes, 62
columns

adding and removing on Task List, 151
adding to custom contacts view, 118

commands, adding to Quick Access 
Toolbar, 251

communication
with contacts, 120–121
with others, 201–203

instant messaging session, 201
voice call, 202–203

completed tasks, deleting, 159
Compose Messages In This Format drop-

down list, 240
computers, selectively copying Outlook 

items between, 227
computer virus, e-mail attachment 

infected with, 79
Conditional Formatting for custom 

contacts view, 119
contact card window, 21
contact groups, 52–54, 106

creating, 52–53
contacts, 34, 99

activities associated with, 109
adding file, 104
adding new, 100–102

from e-mail message, 100–101
with Contact window, 102

adding to Address Book, 106
creating in SharePoint list from Outlook, 

194–195

customizing views, 118–119
inserting item in record, 103–104
map display for, 110
meeting request with, 122–123
organizing, 115–119

with categories, 117
with folders, 115–116

phone call to, 121
printing information, 107–108
searching for, 112–114
sending e-mail to, 120
sharing information on, 124
updating existing with Contacts folder, 

111
use of SharePoint contacts in Outlook, 

193–195
viewing information, 107–110

Contacts folder, 33, 50, 99, 100, 133
creating new contact in, 44
scrolling through, 112
viewing, 105–106

Contact tab in ribbon, More, Map It in 
Communicate group, 110

Contact window for adding information, 
102

Contents Pane, 10
Conversation feature, 13
conversations, 205
copy and paste, 56

RSS links, 92
copying

contacts to SharePoint list, 195
e-mail message text, 56

Create New Folder dialog box, 215
Create Or Open Outlook Data File dialog 

box, 224
selecting existing PST file in, 225

Create Outlook Data File dialog box, 229
Create Rule dialog box, 86



Eudora  255

Current View menu, 44
custom calendar groups, 16
customizing Outlook, 237

Calendar option, 241–242
message format choices, 239–240
Navigation Pane, 243–247

adding shortcuts, 244–247, 245–248
showing or hiding, 243

Quick Access Toolbar, 251
read and delivery receipts, 238
ribbon, 248–250

adding tab, 249–250
turning on or off, 248

D
daily calendar agenda, sending to mobile 

device, 176, 177
Daily Task List, 150
Data Files tab in ribbon, 231
data retrieval from another program, 41–42
Date Navigator, 126
dates for tasks, changing, 155
Day view for calendar, 126

events in, 138
default message format, 240
deleted categories, 208, 211
deleted contacts, undoing, 112
Deleted Items folder, 76, 159, 220

emptying, 219, 221
space used by, 219

deleting
categories, 210
completed tasks, 159
e-mail messages, 76
file, item or object from Calendar item, 

141
items from folders, 220
items from mailbox, 219

delivery receipts for e-mail messages, 238
desktop, dragging Outlook icon to, 32
distribution lists, 52. See also contact 

groups
document libraries, use of SharePoint in 

Outlook, 196–197
domain, blocking mail from, 85
downloading

full RSS feed article, 98
RSS feed content, 93

Draft messages, reviewing, 68
Drafts folder, 33, 69
dragging

contacts to folder, 115
items to create shortcuts, 246
moving items without, 217
to move items to folder, 216
to move RSS folder, 95
to reschedule meeting, 139

due date for tasks, 153

E
e-mail, 47

new features, 13–14
e-mail accounts, 36–39

adding manually, 38–39
e-mail addresses

for contacts, 102, 120
for meeting attendees, 136
searching for partial, 114

e-mail messages, 34. See 
also attachments, to e-mail

adding new contact from, 100–101
addressing, 48
alerts to mobile device for, 178–179
attaching files, 65
to contact group, 54
deleting, 76

displaying related together, 13
editing, 55
editor for, 57
filter rule based on, 86
follow-up for, 89–90
format choices for, 239–240
formatting text, 57–58
for name in Address Book, 51
for sending task assignment, 166
for task status report, 160–161
forwarding, 82
hyperlinks in, 57
importing from other programs, 40
including files, 64–65
manually transmitting, 67
moving and copying text, 56
moving between folders, 13–14
opening, 75
printing, 78
priority levels, 238
read and delivery receipts, 238
reading, 74–75
receiving, 72–73
receiving on mobile device, 179
reply to, 81
reviewing Sent messages and drafts, 

68–69
saving, 77
sending, 66–67
sending to contacts, 120
sorting by date, 74
starting new, 15

e-mail server, 71
embedding picture in HTML e-mail 

message, 240
emptying Deleted Items folder, 219
equipment, scheduling use, 134
Eudora, 36

importing from, 40



256  event, nontraditional holiday as

event, nontraditional holiday as, 242
events

adding file to, 141
adding Outlook item to, 140
adding to Calendar, 132–133
changing scheduled date, 133
reminders for, 144
updating information, 138

Excel spreadsheet, importing data from, 
226

exception to rule for e-mail message 
alerts, 179

Exchange Server
data in mailbox, 223
new features, 15
Outlook data storage in mailbox, 235

Exchange Server accounts
configuring mobile alert settings for, 

174–175
for free/busy time, 131

exiting Outlook, 32
and emptying Deleted Items folder, 221
before backing up PST file, 231

Expand the Navigation Pane button, 243
exporting items from Outlook, 228–229

F
faxes, search folder for messages with 

attached, 211
file formats

for e-mail attachments, 65
for saving message, 77

File menu, 10
New Entry, 106

files
adding object to Calendar from, 142–

143, 143–144
adding to Calendar item, 141

adding to contacts, 104
adding to task, 164
management, 205

File tab in ribbon
Account Settings, 38, 95, 224, 230

Manage Mobile Notifications, 174, 
176, 178

Advanced
Send/Receive, 72

Backstage view, 10
Cleanup Tools

Archive, 234
Mail Cleanup, 218

Open, Import, 36, 40, 41
Export To A File, 228

Options, 233
Advanced, 45

Print, 78, 108, 130, 169, 170
Save As, 77

Filter dialog box
for exporting items, 229
for import data, 227

filtering. See also Rules Wizard
for custom contacts view, 119
junk e-mail, 71, 83

finding name in Address Book, 51
Firefox, 36
First Day Of Week drop-down list, 241
flagging message for follow-up, 89
Folder list, 8, 33
Folder Options applet, 4
folders, 205, 215–217

adding to personal, 225
archiving items from, 234
AutoArchive options, 218
cleaning up, 218–219
creating, 215
creating shortcuts for, 244–245
deleting items, 220–221

for organizing contacts, 115–116
for RSS feeds, 94–95

changing, 95
name changes, 94

moving items to, 216
offline, 235–236
synchronization for Cached Exchange 

Mode, 236
folders in Outlook, 30, 33

moving messages between, 13–14
opening, 35
reviewing items, 34

Folder Size dialog box, 219
Folder tab in ribbon, New Folder, 115, 215
fonts

changing for e-mail message, 58
for card headings and card fields, 119
for HTML stationery, 63
for signature, 60

Format Text tab in ribbon, 58
for e-mail message, 239

formatting e-mail message text, 49, 57–58
forwarding

calendar item, 145
as iCalendar, 146

contact item, 124
e-mail message, 82
messages

configuring, 185
tasks, 171

free time
calendar display of, 16–17
Exchange Server account for sharing, 

131

G
Global Address List (GAL), 193
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H
Help, 46
hiding Navigation Pane, 243
holidays, customizing, 242
Home tab in ribbon

Address Book, 106
Categorize, 206

All Categories, 207
Day button, 152, 241
Find group, Address Book, 50
Forward, 82
Go To group, Today button, 126
Junk, 83

Block Sender, 84
Junk E-mail Options, 85

Manage Rules & Alerts, New Rule, 87
Meeting, 122
Move, 97, 217
New Appointment, 129
New E-mail, 48, 238
New Items, 52
New Meeting, 134
New Task, 156
Reply, 81
Reply All, 81
RSS, Download Content, 93
Rules, Manage Rules And Alerts, 86
Week button, 152

HTML, 77
for e-mail message, 239, 240

HTML Message format
for e-mail message, 57

HTML stationery, 62–63
editing, 63

hyperlink
in e-mail messages, 57
inserting file as, 164, 165

I
iCalendar, 145, 146
IMAP services, 36
importing

e-mail accounts, 36–37
from another program, 40–42
items into Outlook, 226–227

Inbox, 6, 33, 74, 215
calendar preview from, 18–19
follow-up flag, 90
keeping open with Contacts open, 102
managing, 76–78
opening, 8, 13

Inbox view, 30
infected attachments, 79
information management, 205
inserting

file in calendar item, 141
item in contact record, 103–104
items into tasks, 162–165
objects, files and items in Calendar item, 

140
inserting pictures in e-mail message, 64
Insert Item dialog box, Text Only option, 

140
Insert Object dialog box, 143
Insert Picture dialog box, 64, 240
Insert tab in ribbon

Attach File, 165
Attach File button, 141
Attach Item, 103
Illustrations group

Picture, 240
Include group

Attach File, 65
Outlook Item, 162

Picture, 64
Text group, Object, 142

installing Outlook, 2
instant message, 21
instant messaging session, starting, 201
Instant search, 113
interface

Navigation Pane, 8–9
new features, 6–12
ribbon, 6–7
views, 12

Internet connection, 183
Internet Explorer, 174
Internet service provider (ISP), 36
invitation

calendar preview for, 18–19
sending, 20

invitation to meeting, 135
italic text, 58
items

clearing category from, 210
dragging to create shortcuts, 246
exporting from Outlook, 228–229
importing, 226–227
inserting in contact record, 103–104
moving to folders, 216
moving without dragging, 217
restoring, 232
selectively copying between computers, 

227

J
jargon, 1
journal entries, 34
junk e-mail, 83–85

filtering, 71
fine-tuning, 85

Junk Mail Senders List, adding to, 84–85
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L
Library tab in ribbon, Connect & Export, 

Connect To Outlook, 196
LinkedIn, 22
local data file, 224
locating new messages, 74
location

for backup files, 230
for calendar event, 133

M
macros, adding to Quick Access Toolbar, 

251
Mailbox Cleanup Tool, 218–219, 219–220
Mail icon, 8, 182

Search Folders branch, 211
MailTips feature, 15
Manage Mobile Notifications option, 174
Map Custom Fields dialog box, 42
maps, displaying for contact, 110
marking RSS feed messages, 96
Master Category list, categories deleted 

from, 208
meetings, 34

adding file to, 141
adding Outlook item to, 140
changing date and time, 136
creating, 134–135
preview, 18–19
recurring, 123, 125
reminders for, 144
request for, 19, 20
rescheduling, 139
scheduling with contacts, 122–123

Meeting Series tab in calendar, 146

Meeting tab in ribbon
Forward button, 145

Forward As ICalendar, 146
Show group, Scheduling Assistant, 134
Tracking button, 139

messages. See e-mail messages; See text 
messages

instant, 201
managing threads, 205
search folders for locating, 211

messages in RSS feeds
management, 96–98
marking and unmarking, 96
moving between folders, 97

Message tab in ribbon, 6
Microsoft Exchange Server, 36
Microsoft Exchange Server 2010 mailbox, 

175
Microsoft Outlook Express, 36
Microsoft SharePoint, 187. See 

also SharePoint
Microsoft Word, 57
Minimize the Navigation Pane button, 243
minimizing Navigation Pane, 243
mobile devices

alerts to, 173
Calendar alerts setup, 176–177
configuring alert settings for Exchange 

Server accounts, 174–175
configuring message forwarding, 185
receiving e-mail on, 179
reminders setup, 184
sending alerts from Outlook, 183–185
server alerts to, 26

mobility, 26–28
Month view for calendar, 126

events in, 138
mouse, 4
Move Items dialog box, 217

moving
e-mail message text, 56
items to folders, 216
items without dragging, 217
messages between folders, 13–14
RSS feed messages between folders, 97

MSN Messenger, 199

N
names

changes
for categories, 209
for search folders, 214

finding in Address Book, 51
for contacts folders, 116
for custom ribbon tabs, 249
for RSS feed folder, 94
of tasks, 153

Navigation Pane, 8–9
archive display, 15
Calendar icon, 16, 126
collapsing, 30
Contacts icon, 105, 109, 110
customizing, 243–247
Drafts folder, 69
expanding, 9
Folder List button, 216
folders access with, 33
Inbox, 6, 75
Mail button, 74
Mail icon, Search Folders, 212
opening folder, 35
RSS Feeds, 92, 93
Sent Items folder, 68
Shortcuts pane, 244
showing or hiding, 243
sizing, 127
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Tasks, 151
Team branch, 16

Netscape, 36
network servers for linking files in tasks, 

164
New Entry dialog box, 106
news feeds. See RSS feeds
New Signature dialog box, 60
non-Outlook items, shortcuts for, 247
notes, 34
notifications of Calendar updates, 177

O
objects, adding to calendar item from file, 

142–143
Office Communications Server (OCS), 187
Office Communicator, 121, 187, 199

for voice call, 203
Office themes for messages, 62
offline folders, 235–236
Offline Help, 46
Online Help, 46
online status, viewing, 199–200
opening

attachments, 79
e-mail messages, 75

Options dialog box
Advanced, 67
Advanced page, 45
Mail, 59
Mobile page, Configure Forwarding, 

185
Options tab in ribbon

Bcc, 6–7
Show Fields, Show Bcc, 160

organization for contacts, 115–119
with categories, 117

organization of data, 205. See also folders
Outbox, 67

placing message in, 66
Outbox folder, 215
Outlook

installing, 2
multiple options for tasks, 2
starting and exiting, 32

Outlook data files, 223, 224–225
archiving, 233–234
archiving to, 234
importing data to, 226–227
restoring from backup, 232

Outlook Express, importing from, 40
Outlook item, 34–35

adding to calendar item, 140
adding to task, 162–163
opening, 35

Outlook item window, overview, 31
Outlook Journal, 121
Outlook Options dialog box, 233
Outlook profile, local data file for, 224
Outlook program window, overview, 30
Outlook rules, 71
Outlook Social Connector for SharePoint, 

198
Outlook Today view, 43

P
paper clip icon, 79
paragraph, creating in e-mail, 49
People Pane, 22–23, 198
% Complete property of task, 154, 158
permissions in SharePoint calendar, 191
personal folder file, 223
Personal Folders dialog box, 231
phone call to contacts, 121

pictures
including in HTML e-mail message, 240
inserting in e-mail message, 64

Plain Text, for e-mail message, 239
pocket PC, alerts to, 173
POP3 services, 36
predefined search folders, 211
Presence Display, turning on, 199
presence of users online, 21
Preview Pane, View Article, 98
Print dialog box, 108, 169
printer, selecting for calendar printing, 

148
printing, 10–11

appointments, 130
calendar, 147–148
calendar item, 148
e-mail message, 78
task item, 170
task list, 169

priority levels for e-mail messages, 238
Private button for tasks, 154
project category, 205
Prompt Before AutoArchive Runs option, 

233
PST files, 223

backup of, 230–231
creating, 224–225

publishing calendar, 17

Q
Question Mark button, 46
Quick Access Toolbar, 7, 30, 251

Quick Print, 78
Undo Flag, 152

Quick Print, 170
Quick Steps, 13, 205
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R
reading e-mail, 74–75
Reading Pane, 34

RSS feed preview in, 93
sender’s online availability display in, 

200
turning off, 75

reading RSS feed article online, 98
read receipts for e-mail messages, 238
Really Simple Syndication (RSS). See RSS 

feeds
receiving e-mail, 72–73
recovering deleted messages, 76
recovery from backups, testing, 234
recurring appointments, 137
recurring meetings, 123, 125
recurring tasks, 156–157
“RE:” in subject line, 81
reminders, 144

for meetings, 123
for tasks, 150
setting up for mobile devices, 184
sound for, 155

removing. See deleting
reply to e-mail, 81
Request A Delivery Receipt option, 238
Request A Read Receipt option, 238
resizing. See sizing
resources, scheduling use, 134
retention policies, administrator settings 

for, 233
reversing sort order of messages, 74
ribbon, 30. See also names of individual 

tabs
adding tab, 249–250
new features, 6–7
turning on or off, 248

Rich Site Summary. See RSS feeds
Rich Text, for e-mail message, 239
Rich Text Format

and HTML stationery, 62
for e-mail message, 57

RSS Feed dialog box, 92
RSS feeds, 91

adding automatically, 92
downloading full article, 98
folder name changes, 94
folders for

changing, 95
for calendar updates, 189
message management, 96–98
viewing, 93

Rules Wizard, 86–88
creating rule based on message, 86
creating rule from scratch, 87–88

S
saving

attachments to e-mail, 80
e-mail messages, 77

Scheduling Assistant, 134, 136
Search Folder Criteria dialog box, 212
search folders, 211–214

creating custom, 212–213
modifying, 214

searching
for activities associated with contact, 

109
for contacts, 112–114
for older messages during cleanup, 219

Search tab in ribbon, 24–25
Search Tools in ribbon, 114
selected tasks, printing list, 169
Select Members dialog box, 52
Select Names dialog box, 48, 55

sender
removing from Junk Mail list, 85
sorting e-mail by, 74

sending
e-mail messages, 66–67
invitation to meeting, 20
text message, 28

sending text messages from Outlook, 182
Send/Receive tab in ribbon

Send/Receive All Folders, 73
Send/Receive Groups, 73

Sent messages, reviewing, 68
server alerts to mobile device, 26
Setup Wizard, 2
SharePoint

adding calendars to Outlook, 188–192
connecting SharePoint 2007 calendar, 

190
connecting SharePoint 2010 calendar, 

188–189
contacts use in Outlook, 193–195
creating calendar items in Outlook, 

191–192
creating contact from Outlook, 194–195
document libraries use in Outlook, 

196–197
Outlook Social Connector, 198

SharePoint Lists, 8
SharePoint Workspace, 197
sharing contact group, 52
sharing information

for tasks, 169
from Calendar, 145–146

shortcut for Outlook, 32
shortcuts

creating for folder, 244–245
dragging items to create, 246
for non-Outlook items, 247
for Web sites, 245
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Show Columns dialog box, 118
signatures, 59–61

choosing, 61
Signatures and Stationery dialog box, 59, 

63
Signatures And Stationery dialog box, 61
Simple List View for tasks, 150
sizing Navigation Pane, 127
SMS provider, 26, 28
SMS service account, 180
social networking, 22, 198
software

creating shortcut for, 247
for opening attachments, 79

sorting
e-mail by date, 74
task list, 151

sound for reminder, 155
spam, 36, 83. See also junk e-mail
spreadsheet

embedding portion in appointment, 
142

importing data from, 226
starting Outlook, 32
Start menu, Programs/Startup folder, 32
Startup view, 45
stationery, HTML, 62
status bar, total number of e-mails and 

unread e-mails on, 73
status of task, changing, 155
Status property of task, 154
status report for assigned task, 167, 168

sending, 160–161
strikethrough, for completed tasks, 158
subfolders

creating, 215
moving items to, 216

subject
for calendar event, 133
of meeting invitation, 135

Subject field for e-mail message, 49
surveys on Web sites and junk e-mail, 84
synchronization of document library, 196
synchronization of folders for Cached 

Exchange Mode, 236

T
tabs in ribbon

adding, 249–250
turning on or off, 248

task item, printing, 170
Task Item Window, opening, 150
Task Recurrence dialog box, 156, 157
tasks, 34

adding file to, 164–165
assigning to another, 166–168

accepting or rejecting, 168
assigning to contacts, 122
deleting completed, 159
forwarding, 171
inserting items into, 162–165
marking as complete, 158
modifying and updating, 158–161
opening, 43
printing list, 169
recurring, 156–157
reminders for, 150
sending status report for assigned, 160
setting or changing properties, 154–155
sharing information for, 169–171
viewing, 150–152

Tasks folder, 149, 150
adding task, 153–155
opening, 151

Task tab in ribbon
Follow-Up, Add Reminder, 150
Manage Task

Assign Task, 166
Send Status Report, 160

Respond, Forward, 171
Show group, Details, 150

telephone call to contacts, 121
text messages

for alerts, 26–27, 27–28
sending, 28
sending from Outlook, 182

Text Messaging Notifications dialog box, 
176

text messaging service, setting up, 180–181
text wrap, 49
today, returning to in calendar, 127
Today view, 152
To-Do Bar, 126, 128, 150
to-do list. See Tasks folder
tracking time consumed on phone calls, 

121

U
UNC path, 164
underlined text, 58
undoing

deleted contacts, 112
deleted message, 76
deleting items, 220
moving item, 217

unified messaging, 175
unmarking RSS feed messages, 96
Unread Mail search folder, 212
unread messages

number indicator on status bar, 73
search folder for, 211

user interface. See interface
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V
vCard format, 124
video session, 203
viewing RSS feeds, 93
View menu, Reading Pane, 74
views, 12, 43–45

customizing for contacts, 118–119
View tab in ribbon

Change View, 12, 44, 105, 111
Simple List, 158

Layout, To-Do Bar, 128
Reading Pane, 22, 198
View Settings, 118

virus, e-mail attachment infected with, 79
voice call, 202–203
voice conferencing application, 121
voice conferencing call, 21
voice mail, search folders for messages 

with, 211
VoIP phone, 121, 202

W
Web sites, creating shortcuts to, 245
Web site surveys and junk e-mail, 84
week, displaying in calendar, 126
weekend days, displaying in calendar, 17, 

127
Week view

events in, 138
vs. Work Week view, 17

Windows Live, 22
Windows Live Hotmail, 36
Windows Live Messenger, 199
Windows Mail, 36

importing from, 40
Windows Messenger, 199
work hours, changing, 241
Work Week view, 127

customizing settings, 241
vs. Week views, 17
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